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Chapter 1: Introduction
SERVICE AND SUPPORT

If you need additional information on how to set up or operate your INTERACT Pro, Pro 8i or AT equipment,
please contact us. We welcome and encourage your comments so we can continue to improve our products
and better meet your needs.

TECHNICAL SUPPORT
Telephone: 1.800.283.5936 (USA) or 1.801.974.3760

Fax: 1.801.977.0087
E-mail: Tech.Support@ClearOne.com
Web site: www.ClearOne.com

Sales and Customer Service
Telephone: 1.800.945.7730 (USA) or 1.801.975.7200

Fax: 1.800.933.5107 (USA) or 1.801.977.0087
E-mail: Sales@ClearOne.com

PRODUCT RETURNS

All product returns require a Return Material Authorization (RMA) number. Please contact ClearOne Technical
Support before attempting to return your product. Make sure you return all the items that shipped with your
product.
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IMPORTANT SAFETY INFORMATION

Read the safety instructions before using this product. This personal speaker phone is not designed for
making emergency telephone calls when the power fails.

Read all safety information before using this product.

1.

© N o o K~ W N

13.
14,

15.
16.

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.

Clean only with dry cloth.

Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that
produce heat.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plughas two blades with one wider than the
other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your
safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they
exit from the apparatus.

Only use attachments/accessories specified by the manufacturer.

Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is
used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

Unplug this apparatus during lightning storms or when unused for long periods of time.

Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as
power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been
exposed to rain or moisture, does not operate normally, or has been dropped.

Use the mains plug to disconnect the apparatus from the AC mains. The mains plug shall remain readily operable.

To completely disconnect unit power from the AC mains, disconnect the unit's power cord from the mains socket. To reconnect
power, plug the unit’s power cord into the mains socket following all safety instructions and guidelines.

Caution: Danger of explosion if lithium battery is incorrectly displaced. Replace only with the same or equivalent type. Battery
should only be replaced by qualified personnel and is not intended as a user serviceable part. Do not expose batteries or battery
pack to excessive heat such as prolonged sunlight, fire or other heat sources.

Never push objects of any kind into this product through cabinet slots as they may touch dangerous voltage points or short out
parts that could result in fire or electric shock.

This product can interfere with electrical equipment such as tape recorders, TV sets, radios, computers and microwave ovens if
placed in close proximity.

CAUTION
WARNING: TO &fu?ﬁm’;ﬁ'n”é‘
PREVENT FIRE OR TRIANGLE ISA
ELECTRICAL SHOCK | JRaNaLE A NG YO0 OF
HAZARD, DO NOT WIIBTH “,Em‘ lms
EXPOSE THIS ACCOMPANYING
PRODUCT TO RAIN THE PRODUCT.
OR MOISTURE. SEE MARKING ON BOTTOM/ BACK OF PRODUCT

Save these instructions

Technical Support: 800-283-5936



Chapter 2: Getting Started

INTERACT SOFTWARE OVERVIEW

ClearOne’s INTERACT software provides an easy interface for configuring system settings and customizing
the audio in your INTERACT conferencing system. While the INTERACT system is designed to work out of
the box for audio conferencing setups, INTERACT Software is required to adjust audio levels and equalizer
settings for the INTERACT components as well as the auxiliary audio devices.

Installing the INTERACT Software

The INTERACT software is available for download at: www.ClearOne.com - Resources - Resource Library
- under the section titled INTERACT. This section contains the latest software and firmware releases and
documentation for your product.

To install the software:

1. If you are installing from CD on a Windows machine, place the CD in the drive tray and close the drive.
If Autorun is enabled, the installer will launch. If you do not have Autorun enabled double-click your CD-
drive icon from My Computer and navigate to the Software folder, then open the folder.

2. If you are downloading the software, unzip the downloaded file to a location of your choice. Open the
folder containing the unzipped setup files.

From this point, the instructions pertain to both a CD or downloaded install. Double-click Setup.exe.
Once the installation wizard launches, read through the instructions. Click Next.

Read the INTERACT EULA, click either “I Do Not Agree” or “I Agree”. If you agree, click Next.
Read the Information screen, click Next

Select the installation folder, click Next

Confirm the installation, click Next

© ® N o g~

The Windows Device Driver Installation Wizard will launch, click Next. This will install the required
drivers for the ClearOne INTERACT product line.

10. When the Device Driver Installation Wizard confirms the status of the drivers, click Finish.
11. Repeat steps 9-10 if asked.
12. The installation is complete. You are ready to use the INTERACT software.

Navigating the INTERACT Software

* The Menus and Toolbar buttons provide quick access to INTERACT software features such as System
Diagnostics, Phonebook, Firmware Uploader and Event Log.

* Helpis available at any time by pressing the Help Question Mark button from the toolbar or press the
F1 key on the PC keyboard.
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*  When the INTERACT Software is started the software will show all available connections. If USB or RS-
232 is chosen the software will connect immediately. If Ethernet is chosen, you will be prompted for a
username and password before connecting. The software can only make one connection at a time.

i Connections ,}
=

CLEAROME-BO
fid

JEREMY

e Lists most common brands of auxiliary audio products (Video Codecs, Sound Cards, VCR'’s and
Amplifiers). The audio settings for these devices have been optimized for use with the INTERACT
system. Users can add and edit their own devices. See the Edit Devices section.

Device Toolbox

* Access the Configuration windows for the INTERACT system by clicking the icons.
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e INTERACT AT Only - COM units are enabled by selecting them from the dropdown boxes (COM Units
are enabled on the INTERACT PRO by selecting the appropriate check box).

Inputs Mixer Console
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Commumnicati on:s

e Shows connection status (Online/Offline) and the name of the connected unit.

CLEARONE-BO: Online |

e Status for Communications: GREEN = Online, YELLOW =
e Telephone In Use: RED = NOT In Use, GREEN = In Use

Connecting, RED = Offline

*  Mic Mute/Gating: RED = Mute, GREEN = Gated, OFF = Not Gated

Communications: = (TCP) Telephone In Use: - Mic Mute/Gating:

Connecting to Units

1
0 -

*  When you connect to the INTERACT unit with a serial cable, the unit is detected when you start
INTERACT Software and a connection to the unit is established. The name of your unit and the online

status are displayed below the Configuration screen.

*  When the INTERACT software is started, it automatically finds

all INTERACT units on the same

subnetwork and displays them in the Connections list. To connect, simply click the unit icon. You will be
prompted to enter the Username and Password. Once a connection is established, the Configuration
screen will appear and the unit name and Online status will be displayed.

* An INTERACT can be connected via USB to your Windows-based PC. The INTERACT software is

compatible with Microsoft Windows XP, Vista and Windows 7.

Chapter 2: Getting Started
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Working Offline

» NOTE: Changes made offline will only take effect once they have been imported to a

connected INTERACT system.

Select either the INTERACT AT or INTERACT Pro depending on your system.
This will open the Configuration Screen where you can set user preferences for your INTERACT system.

1. Click the New File toolbar icon.

Save the file.

1. Click the Open File toolbar button.

A

Using the Open browse window, locate and select your saved file.
Click Open and make desired changes.
Save the file.

»  NOTE: To import an existing file, you must first connect to an INTERACT unit.
Select Import File from the File menu.

Using the Open browse window, locate and select your saved file.

Click Open.

The new configuration settings will be sent to the connected INTERACT unit.

o~ o

The device will require a reboot.

Technical Support: 800-283-5936



INTERACT MIC EX
The MIC EX is a Microphone breakout box with 3 XLR mic/line input channels and a Link Input/Output.

Product features include:

Front
A. Power Indicator

Back

A. Link Connectors: Connect the link line to the IN connector using RJ-45 cable. Connect the breakout
box to the mixer using RJ-45 cable and connect the breakout box’s OUT connector to the mixer’s IN

connector.

B. Microphone Connectors: Connect up to three Mics - the Mics can be Tabletop Mics, Button Mics,
Portable Mics, etc.

Chapter 2: Getting Started
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MIC PODS

Mic Pods can be integrated into an INTERACT system to provide for microphone capabilities when
necessary.

A total of three Mic Pod units can be used per INTERACT device.
One scenario shown below depicts two Mic Pods integrated into an INTERACT system.

INTERACT System Configuration
with Mic Pods Scenario

INTERACT AT
Mixer Unit

INTERACT Dialer to

RJ-11/RS232 Adapter to
INTERACT RS232 Port

COM Module

COM Link Out to Mic Pod #2 Link In

Technical Support: 800-283-5936



INTERACT DIALERS

INTERACT Dialer
The INTERACT DIALER is a wired table top controller designed to add functionality to your INTERACT

device.

INTERACT Dialer-W (Wireless)

The INTERACT DIALER-W is a 2.4 GHz Wireless tabletop control device requiring an INTERACT COM-W
device connected to the INTERACT system.

Both versions of the Dialer have the following keypad features and functions:

LCD Icon | Function
ANTENNA SIGNAL: Indicates commands are received and acknowledged by the base unit
T“ and represents ths signal strength from the base unit to the RF controller.
|

BATTERY: Indicates battery level (RF controller only)

Function

ON/OFF: Press to activate the phone and access the dial tone.
Press again to hang up the phone.

PHONE: Press once to switch from PC mode to standard TELCO mode.
(standard telephone calls can only be made from this mode)

MUTE: Press once to mute all microphones during a call.
Press again to unmute.

FLASH: Press once to perform a quick hanging up then picking up again action.
Press again to reverse the action.

PC: Press once to switch the dialer to PC mode. When enabled in the INTERACT software
the PC mode allows the software dialer to be the active dialpad for Microsoft Office
Communicator or Microsoft Lync. For other UC applications or soft phones, use the user
interface of the UC application or soft phone running on the PC.

MENU: Press once to access the controller programming menu. Once you are in the menu,
this key serves as the Enter key.

B2 @ [x[=F )]

PHONEBOOK: Press once to dial stored numbers. When you are in the phonebook use this
key to delete characters or to go back to the previous screen.

|
|

Down/Up: Press down or up to navigate through the menu or phonebook. Press while in a
call to adjust the call volume.

A

=

A
=

VOLUME: Press while in a call to adjust the call volume.

Chapter 2: Getting Started
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USING THE DIALER

Managing Calls

Most phone specific functions, such as dialing a call or adding a phonebook entry, will be managed from the
wired or wireless dialer. Phonebook and dialer actions can be done through software as well.

To ANsweR A CaLL

«  Press €% on the dialer to answer the call. When there is an incoming call, the phone rings and the LEDs
on the microphones flash.

»  Note: INTERACT can also be set to automatically answer calls using Menu options.

To Make A CaLL
Press « You will hear a dial tone. T CTTTH

2. Dial the number as you would on a standard phone. 18005781234
The number appears on the LCD screen.

»  Note: The dialer accepts a maximum of 44 characters.
No more than 44 characters can be entered.

To PRre-piaL A CALL

1. Dial a phone number
You can press Ml to delete the last digit entered in the pre-dialing string

2. Press €% to send the call.

» Note: The phonebook key will delete the entire dial string if you press it for two seconds.
Pressing and holding the pound (#) key for two seconds will insert a pause into the dialing
string.The duration of the pause is two seconds.

To Enp A CALL
Press €% on the dialer to disconnect the call.
»  Note: INTERACT can also be set to automatically disconnect calls using Menu options.

To Mute/UNMUTE THE MICROPHONES
1. Press 5&’ to mute the microphones.The microphone LEDs will illuminate red.
2. Press 5&' again to unmute microphones. The microphone LEDs will illuminate green.

»  Note: This function mutes all microphones in the room. The microphone LEDs and the mixer
front panel LEDs light red when the microphones are muted.

To Use Speep Diac
* Press and hold the assigned speed dial number on the dial pad.

»  Note: You can dial numbers 1-9 by pressing and holding the assigned number. To dial 10,
press and hold 0.

10 Technical Support: 800-283-5936



1. Press !,._ on the dialer. Tu ‘mmm)

2. Scroll to the entry and press ' Conference *
Product Management
Sales Team l

* Press /V to use call transfer, call waiting or conference calling.

»  Note: This feature is dependent on your PBX service or local phone service. Refer to your PBX
vendor or local telephone service for details.

 Press {)) to increase the volume.
_ Or _
* Press «) to decrease the volume.

PROGRAMMING PHONE PREFERENCES

You can manage the Phonebook,adjust phone settings,such as ring melody and tone, and set preferences,
such as country codes and language, through the menu options outlined below. You can also program these
preferences in the INTERACT software.

Wired Dialer Menu

Phonebook Settings Configuration
Add Ringer Melody Country
| | |
Edit Ringer Volume Language
| | |
Delete Auto Answer Flash
| |
Auto Disconnect LCD
|
Version
|
Wired Control
|
IP Address

Chapter 2: Getting Started 11



Wireless Dialer Menu

I
Settings

Configuration

Ringer Melody

Country

Ringer Volume

Language

Auto Answer

LCD

Auto Disconnect

IP Address

Version

Frequency

RF Radio Test

RF Version

The main menu on the wired dialer gives you three options: Phonebook, Settings and Configuration. On the
wireless dialer you have Settings and Configuration. An asterisk % indicates your position in the menus and

a down arrow | indicates that the menu continues.

Once in menu mode, use the arrow keys to navigate. ¥ moves the cursor to the right. Ais a backspace key.
The !! is a delete key or a back key that moves you to the previous screen. The IMl key saves entries and
moves the cursor to the next line.

Press IM on the INTERACT DIALER to access the program menu.

Yo (EmEE
Phonebook *
Settings

Configuration




Using the Phonebook
The Phonebook stores up to 20 names and numbers. You can add, edit and delete any of the contacts.

1. Press Mto access the menu options. Y TmwEn’
2. Press Mlto select Phonebook. Name
3. Press M again to select Add. Number
4. Type the Name using the keypad. Save
»  Note: Press a keypad key repeatedly to cycle through its characters.
5. Press MIto advance to the Number field.
6. Type the number using the keypad.
7. Press MIto advance to the Save option.
8. Press IM again to save the entry and return to the Phonebook menu.
»  Note: Entries added to the phonebook through the wired dialer are assigned the speed dial
number 0. This really means there is no speed dial associated with this number. You must use
the INTERACT software to edit the speed dial.
1. Press M to access the menu options. Y EEEE}
2. Press M to select Phonebook. Sales Team
3. Scroll to Edit and press M. 8886451234
4. Scroll to a desired name and press M. Save
5. Make changes to the name and number.
6. Press Mto advance to the Save option.
7. Press Ml again to save the changes and return to the Phonebook menu.
1. Press M to access the menu options. Y EEEY
2. Scroll to Delete and press M. Add
3. Choose the entry you want to delete. g:iltete *
4. PressM to delete the entry return to the Phonebook menu.

Chapter 2: Getting Started 13
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Adjusting the Settings

You can select ringer melodies, adjust ringer volume, select the auto answer setting, and activate auto

disconnect, in the Settings menu.

1. Press Mlto access the menu options. Yar LK
2. Scroll to Settings and press M. Ringer Melody *
3. Press Ml again to select Ringer Melody Ringer Level
. . Auto Answer |

4. Select one of the three ringer melodies.
5. Press Mo save the selection and return to the Settings menu.

»  Note: Once you select a melody, you will hear it played through the speakers.
1. Press Mlto access the menu options. Y T
2. Scroll to Settings and press M. Ringer Level
3. Scrollto Ringer Level and press™M. ~—|=mmmmmmmmm——
4. Use 4) or 4 to adjust the volume.
5. Press Mlto save and return to the Settings menu.

»  Note: Ringer volume is indicated by a horizontal bar on the LCD screen.
1. Press Mlto access the menu options. Tan EEEE;
2. Scroll to Settings and press M. After 2 Rings *

After 4 Rings

3. Scroll to Auto Answer and press M. Disable
4. Select After 2 Rings or After 4 Rings.

_Or_

Select Disable to deactivate the Auto Answer function.
5. Press Mto save and return to the Settings menu.

Press M to access the menu options. T T

Scroll to Settings and press M. Enable *

Disable

Scroll to Auto Disconnect and press M.
Select Enable or Disable.

o >~ D=

Press M to save and return to the Settings menu.

»  Note: When enabled, Auto Disconnect will automatically hang up the phone once the other

end is disconnected.

Technical Support: 800-283-5936




Configuration

The configuration menu provides options for selecting countries, languages and RF as well as configuring
the Flash setting.

> w o

o~ 0o~

o b~ o=

Press M to access the menu options.
Scroll to Configuration and press M.
Press M again to select Country.

Select the country where the INTERACT is being used from the list of
available countries.

Press Ml to save the country selection and return to the Configuration menu.

Tar LILLE
USA/Canada *
Europe

Australia/New Zealand |

»  WARNING: This is assigned to the telco for the specific country settings. The country code
must be set correctly in software and the RF Controller to ensure that the unit operates
properly when connected to the telco network and that it complies with the country’s telco
requirements. Changing this code to a country other than the intended country of operation

might cause the INTERACT to be non-compliant.

Press Ml to access the menu options.

Scroll to Configuration and press M.

Scroll to Language and press M.

Select a language from the list.

Press Ml to save the language and return to the Configuration menu.

Press Ml to access the menu options.

Scroll to Configuration and press IM.

Scroll to Frequency and pressM .

Choose a frequency from 1-8.

Press Ml to save the frequency and return to the Configuration menu.

T mmmn;
English

Spanish *
French l
T fTTTH
Frequency 1

Frequency 2 *
Frequency 3 |

» Note: The channel frequency allows the mixer to communicate with the controller. The

frequency in software must match the INTERACT controller frequency.

Chapter 2: Getting Started
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1. Press IMlto access the menu options. Ta ana}
2. Scroll to Configuration and press M. 1000
3. Scroll to Flash Duration and press M. Save
4. Type a duration number from 50-1000 ms.
5. Press Mlto save the duration and return to the Configuration menu.
1. Press MIto access the menu options. - ]
2. Scroll to Configuration and press M. RF Radio Test
3. Scroll to RF Radio Test and pressM. |-
. . . Exit
4. Press Mlto exit and return to the Configuration menu. X
Signal Level Reliability
0-4 bars Fair
4-8 bars Good
9-12 bars Better
13-16 bars Best
»  Note: The RF Controller will send out a radio signal and display the signal strength between
the Controller and the mixer. Use this feature to ensure the mixer and Controller are set to the
same frequency and to verify of the signal strength. Use the above chart to determine the
reliability of the signal.
1. Press M to access the menu options. Ya "mE
2. Scroll to Configuration and press M. Contrast 0 *
Contrast 1
3. Scroll to Contrast and press M. Contract 2 |
4. Choose a setting (0-3)
5. Press Mto exit and return to the Configuration menu.

Technical Support: 800-283-5936




Press Ml to access the menu options.

Scroll to Configuration and press M.

Scroll to IP Address and press M.

The IP address for the INTERACT unit will display on the LCD.
Select Exit to return to the Configuration window.

Press IMto access the menu options.
Scroll to Configuration and press M.
Scroll to Version and press M.

The Version of the RF Controller firmware will display on the LCD.

Select Exit to return to the Configuration window.

T LTITH
IP Address
191.151.147.102
Exit
T L H
Version
1.0.0
Exit

Chapter 2: Getting Started
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INTERACT COM / COM-W (WIRELESS)

INTERACT COM

The INTERACT COM is an interface device used to add USB Audio and Headset Audio to an INTERACT
system. The INTERACT COM provides all the features as the INTERACT COM-W except for the Wireless
feature as described below.

INTERACT COM-W (Wireless)

The INTERACT COM-W is an interface device used to add USB Audio, Headset Audio and a Wireless
INTERACT DIALER to an INTERACT system.

Product features include:

Front

A. Power Indicator

Back

A. Link In/Out Ports: Link Input and Output
Ports Connect G-link Enabled Devices to the
INTERACT COM and COM-W

B. HS Port: Connects a telephone headset to the
COM and COM-W

C. USB 2.0 Compatible Port: Connects USB
Devices to the COM and COM-W Unit

D. Control/Status Port: GPIO Port

Pin 1: Master Microphone Mute Control

Pin 2: Master Mocrophone Mute Status

Pin 3: On/Off Hook Control

Pin 4: On/Off Hook Status

Pin 5: 5 VDC (up to 40 mA)
6. Pin 6: Ground

E. Antenna (COM-W only): Allows Wireless
Communication for transfer commands
between the COM-W and the INTERACT Unit

SANE SRR\

Technical Support: 800-283-5936



NETWORK CONNECTION

Network Connection allows you to connect to any INTERACT system on your network using an IP address or
a unique network name.

Using Network Find

Click the Network Find button on the toolbar (or use the menu option Tools->Network Find).

»  NOTE: INTERACT Software will automatically detect units located on the same subnetwork.
You only need to use Network Find to locate units outside of the subnetwork. This is based on
the assumption that your LAN is configured correctly. If your LAN is not configured correctly,
please refer to your IT Administrator.

. Enter the IP Address or Network Name of the system to which you want to connect.
2. Click Ok.
You will see a Password Prompt window. Enter the User Name and Password of the networked

system.
4. Click Ok. The system icon will appear in the Connection list and the Configuration screen will open.
PHONEBOOK

INTERACT Software features a Phonebook utility which stores up to 20 phone numbers. These numbers are
also assigned a speed dial number for dialing convenience through the INTERACT Controller. Phonebook
entries are listed in alphabetical order, speed dial number or number. You can add, edit or delete an entry
from the Phonebook window.

Phonebook Edit

Click the Phonebook button on the toolbar (or use the menu option Tools->Phonebook Edit).

-

Click Add
Enter the Name and Number.

Enter a Speed Dial Number (1-20). If you don'’t enter a speed dial number, INTERACT Software will
automatically assign one. Alternatively, the user can assign a speed dial number of None which will
prevent a speed dial number from being assigned.

4. Click Ok

. Select the entry you want to delete.
2. Click Delete

Select the entry you want to edit, click Edit.
Make desired changes to the entry.
Click Ok. Confirm the deletion.

Chapter 2: Getting Started
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REGIONAL SETTINGS

You can set the date and time in the Regional Settings window to ensure accurate time stamp on log files.
The Regional Settings window is accessed through the Regional Setting toolbar button (or use the menu
option Tools->Regional Settings).

Date / Time

Select the Local Time check box. The Local Time and Date boxes are now active.
Enter the current Date and Time.

Select Use Daylight Savings if your region observes daylight saving time.

Select the correct Time Zone.

o > 0o

Click Ok to save settings and close the window.

Uncheck the Use Local Time check box.

Enter the IP Address for the time server.

Select Use Daylight Savings if your region observes daylight saving time.
Select the correct Time Zone.

H W o

5. Click Ok to save settings and close the window.

If the device is connected to a network using DHCP, Time Server is included with DHCP options and will auto
populate depending on those settings.

EVENT LOG

The Event Log keeps a user-definable record of events such as passwords, dialing, reboots and errors. The
selected events are tracked and listed in the Event Log. The INTERACT software must be connected to a unit
to view the Event Log.

Using the Event Log

Click the Event Log toolbar button (or use the menu option Tools->Event Log)

e Select the events you would like to log

Click the Save button
2. Name the file
Click Save. The log is saved as a .txt file

Click the Print button
Select the printer
Click Print

20 Technical Support: 800-283-5936



Error Messages

When the INTERACT system encounters an error, an Error lcon will appear in the lower left corner of
INTERACT Software. Review this log to troubleshoot problems.

¢ (Click the Error Icon m in the lower left corner of the INTERACT window

* C(Click Clear
» NOTE: Users can also select and copy error messages.

SYSTEM CHECKS

» NOTE: To perform a diagnostic the INTERACT system must be connected.

The System Checks window allows you to check your INTERACT system to be sure all parts of your system
are connected and working properly. You should run the system checks before all uses of the INTERACT and
once a week to troubleshoot any problems.

Open System Diagnostics

e Click the System Checks toolbar button. Alternatively, System Checks can be selected from the
Tools->System Checks menu option.

¢ (Click the Start button.

You will hear a tone as the INTERACT checks attached loudspeakers and mics. When the check is complete,
lights will indicate the status of each component. Green indicates the part is connected and functioning. Red
indicates a problem with the component.

FIRMWARE LOADER

Updates and enhancements to your INTERACT system are made available through new software and
firmware releases which can be downloaded from the ClearOne Web site. Once you have installed the new
software version, you will need to upload new firmware files to your INTERACT units.

Connect to the INTERACT Unit

Click the INTERACT unit icon in the Connection list. If you are connecting via IP you will be prompted to enter
the User Name and Password (defaults are User Name = “clearone”, Password="interact” - all lower
case).

Once a connection is established, the Configuration screen will appear and the unit name and online status
will be displayed.

It is recommended that you make a backup of your original Site File, located in the same location you saved
the file. The firmware will be located in the INTERACT Software folder, located in:

C:\Program Files\ClearOne\lnteract\1.0\firmware

Chapter 2: Getting Started
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Upload Firmware

1.
2.
3.

Click the Firmware Loader button on the toolbar.
Click the File button
Browse to the correct file located in INTERACT Software folder:
C:\Program Files\ClearOnelInteract\1.0\firmware
Click Open
Click the Update button.
The File Transfer Progress bar will indicate when the firmware has been uploaded.

»  Note: Once the update is complete the unit will reboot. When the firmware is updated and the
unit rebooted, it returns to the default settings.

INTERACT COM UPDATER

Updates and enhancements to your INTERACT system are made available through new software and
firmware releases which can be downloaded from the ClearOne Web site. Once you have installed the new
software version, you will need to upload new firmware files to your INTERACT units. The Updater works for
both the COM as well as the COM-W devices.

Connect to the INTERACT unit

o o~ w

» NOTE: Your INTERACT COM must be linked to your INTERACT unit. Correct linking and
power will be indicated by a blue light on the front of the INTERACT COM.

Connect the INTERACT COM to your Computer with a USB cable. If you are asked to install drivers
follow the onscreen wizard.

Once the INTERACT COM is connected, click the INTERACT COM Updater button on the toolbar (or
Tools/INTERACT COM Updater).

Click the Select File button

Browse to the correct file located in C:\Program Files\ClearOne\Interact\1.0\firmware
Click Open

Click the Update button.

During the upgrade process you may be asked to install drivers; these USB device drivers are necessary to
continue the INTERACT COM update. Follow the prompts in the Device Driver Wizard to complete driver
installation and INTERACT COM Update.

Technical Support: 800-283-5936
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SERIAL COMMANDS

The INTERACT Serial Commands guide can be found as a separate document.

The document contains a list of applicable Serial Commands for the INTERACT AT and INTERACT Pro
models, along with their uses and applications.

Connecting with Telnet

Users can connect to any unit via RS-232 and Telnet. Available Telnet commands are the same as those

used in the Serial Command section of the INTERACT Serial Commands guide.

e Use the Client of your choice
e Telnet uses Port 23

e The Username and Password are the same as used by INTERACT. The default username is “clearone*
and the default password is “interact” - both lowercase.

» NOTE: The INTERACT Pro 8i cannot be controlled through RS-232 and Telnet.

Pin#

User Definable

Control

|

N

DCD

TXD

RXD

DTR

Ground

DSR

CTS

Zl|lZzlZz|1Z2|1Z2|1Z2|Z2

RTS

OO |IN|O|Oo|A~]|w|IN

No Connection

» NOTE: To avoid communication errors, ClearOne recommends using all nine pins when

connecting to the RS -232 port.

Chapter 2: Getting Started
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INTERACT AT

The ClearOne INTERACT AT is a mixer that interfaces with the MIC and MIC EX via an RJ-45 cable. It is
equipped with two (2) Line Inputs, two (2) Line Outputs, a 5-Watt Amplifier and Telephone Hybrid.

Features of the INTERACT AT include:

Front

A.  On/Off hook indicator

B. Microphone Indicator: Indicators show which microphone channels are active
C. Input Metering: Shows current Input Level

D. USB 2.0-Compatible Input

Back
A. Telephone Interface: Connect an analog phone line to the INTERACT

B. RS-232 Control Port: Used to connect to the INTERACT Software or control from a 3rd-party controller
such as AMX or Crestron

C. Camera Control: Video System Control Architecture port used to control a VISCA compatible camera

D. Ethernet Port: 10/100 Mbps Ethernet port. The LEDs adjacent to the port indicate connection status
and packet traffic activity

E. MIC Pod Link-In Input: Input for the INTERACT MIC Pod accessory. The INTERACT MIC EX, INTERACT
COM and INTERACT COM-W can also be placed on this port

F. Playback/Record Input/Outputs: Left and right channel input and output RCA jacks used to connect
playback and recording devices

G. Line Input/Output: Mono line input and output RCA jacks
H. Speaker Outputs: Left and Right Push Terminals, 5-Watts/Channel, 8Q
|.  Power Adapter Input: 12 VDC 1.25 A

»  WARNING: Use the Link In and Link Out ports with INTERACT Devices ONLY. Connecting any
other devices to the Link In and Link Out ports, including ClearOne Converge and Converge
Pro products, or Power Over Ethernet (PoE) devices, will result in severe equipment damage.

24 Technical Support: 800-283-5936



INTERACT AT - BASIC CONNECTIONS

Connecting the INTERACT AT should be a smooth process. Once basic connections for audio/video
conferencing are made, the system is ready to use.

The diagrams below illustrate typical Wired and Wireless INTERACT AT installations.

INTERACT AT Wired Connection Diagram

INTERACT COM (wired)

Enterprise Handset (OPE)
- UsB
f Audio
n INTERACT Mics*
% “

PC with Softphone or I

Video Conferencing Application (OPE)
' _ INTERACT MIC EX"

Wired Dialer
Link In l—»

Speakers
i
* INTERACT Mics and Mic EX can be Ethernet
To Telephone Line

used in the same system up to total of three

Out | In ————— To LAN (For System Control)

OPE = Owner Provided Equipment
[= 12

Video Conferencing System (OPE)

INTERACT AT Wireless Connection Diagram

Tabletop Controller

_ INTERACT COM (wireless)
I _
1
| R ————— —y -—‘

Enterprise Handset (OPE) usB u
A Audio
1Mk ‘ INTERACT Mics*

PC with Softphone or |

Video Conferencing Application (OPE)
_WTERACT MIC EX*

Link In ,—»
- Speakers
Mi
* INTERACT Mics and Mic EX can be Ethernet
To Telephone Line

used in the same system up to total of three

OPE = Owner Provided Equipment TOLAN{For System Control)

Video Conferencing System (OPE)
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INTERACT AT - AUDIO CONFERENCING SETUP

1. If you are installing the mixer into a rack, remove the side panels, rotate them and then reattach.
2. Connect the first Microphone Breakout Box to the mixer with the included CAT5 cable.

3. Connect the second and third Breakout Boxes using CAT5 cables (A total of 3 Microphone and 1 COM
Breakout Boxes can be connected).

Connect the Microphones to the Breakout Boxes, as needed.
Connect the speakers to the mixer.
Using the RJ-11 cable, connect an analog telephone jack to the Line jack on the mixer.

N o ok

Using an RJ-11 cable (not supplied), connect an analog telephone set to the Set jack on the mixer
(optional)

8. Using the CATS5 cable, connect the mixer to the network. (Network settings can be changed in
INTERACT software.)

9. Connect the power supply to the INTERACT AT.

10. If using the wired controller, connect the controller to the mixer's RS-232 serial port using the supplied
RJ-11 to DB-9 adapter. If using the RF controller, attach the external antenna and turn it until it is upright.

11. If using the RF controller, insert four AAA batteries into the battery compartment in the bottom of the
Dialer-W unit.

AUXILIARY DEVICES (INTERACT AT)

The mixer allows connection to a number of different audio and video peripherals, such as video codecs,
VCRs, DVD players, cameras and computers.

Connecting Video Codecs and Amplifiers

Line Input/Output devices such as video codecs, amplifiers and sound cards can be connected to the Line
In or Line Out connectors on the INTERACT mixer. These connectors provide mono-audio.

Connecting a Video Codec
1. Using an RCA cable, connect the Line In on the INTERACT mixer to the line out on a video codec.
2. Using an RCA cable, connect the Line Out on the INTERACT mixer to the line in on a video codec.

Connecting an External Amplifier

Using an RCA cable, connect the Line Out or Record Out on the INTERACT mixer to the Line In on an
amplifier.

»  NOTE: Use the INTERACT software to adjust the equalization and volume of these devices.
Refer to pages 26-31 for more information. When using the INTERACT software, be sure to
drag the amplifier to the correct device (either Line Out or Record). This will properly assign
the AEC reference and change the volume command on the controller to control the external
amplifier volume.

» NOTE: The INTERACT COM allows direct interface to a PC from the USB for the audio
connection.

Technical Support: 800-283-5936



Connecting VCRs and DVD Players

You can record your Audio/Video conference or play audio using a playback device such as a VCR or DVD
player.

1. For recording, connect the Left and Right Audio Out on the INTERACT to the Left and Right Audio In
on the VCR or DVD player.

2. For playback, connect the Left and Right Audio IN on the INTERACT to the Left and Right Audio Out
on the VCR or DVD player.

Connecting PTZ Cameras

The INTERACT system provides voice-tracking capabilities through VISCA control port connection to a Pan,
Tilt, Zoom camera. Voice Tracking allows the camera to move to a preset position based on microphone
activation.

e Connect the camera to the Camera Control port on the mixer.

Serial Control Connection

You can connect a computer or a control device, such as an AMX or Crestron, to the INTERACT mixer
through the serial control port.

See the on-line INTERACT Serial Commands document for a list of serial commands.

* Connect the computer to the R§-232 Control port on the back of the mixer using a 9-pin straight-
through serial cable.

USB Control Connection
You can also connect a computer to the INTERACT through the USB port.
* Connect computer to the USB port on the front of the mixer using a USB cable.

Digital Phones

If you have a digital (PBX) telephone service, you can run an analog extension from the PBX (recommended
for best performance) or use a digital-to-analog telephone line converter. For more information, contact
ClearOne Technical Support.

»  NOTE: If you connect the INTERACT through a digital-to-analog line converter, you will not be
able to use the tabletop controller or the INTERACT software dialing interface to make calls.
You will instead need to dial from the digital phone. The phone handset must be kept off hook
for the duration of the call.

Connect one end of the telephone cable into the Line jack on the back of the mixer and the other end into
the digital-to-analog converter.

1. Connect the converter’s power adapter into an electrical outlet.

2. Connect a second telephone cable from the converter to a PBX phone. Consult the converter's user
manual for more information.

Chapter 2: Getting Started
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DEVICE TOOLBOX - INTERACT AT

The Device Toolbox Editor allows you to add audio devices to the pre-configured Device Toolbox list
for future system setup. You will need to save the INTERACT file, which can then be imported into the next
INTERACT AT unit you are configuring. If you want to only copy over the settings for a specific device, you
will need to copy and paste the settings.

Using the Device Toolbox Editor

—

© o~ N =

Select the device category from the Device Toolbar, click the “+"” symbol to expand.
Right-click the device to edit and select Device Toolbox Editor.
Alternatively, from the Tools menu, select the Edit Device List option.

Click Add.

Select the Device Type from the Device Type list.

Enter the Name of the Manufacturer.

Enter the ModelNumber of the device.

Enter the Equalization levels and the Gain settings.

Click Ok. The new device will appear in the Toolbox Editor window and in the Device Toolbox.

In the Device Type list, select the device you want to modify.
The Edit Device window opens. Make the desired changes.
Click Ok.

In the Device Type list, select the device you want to delete.
Click Delete.
Click on the “Ok” button to confirm that you want to delete the device.

Technical Support: 800-283-5936



MIXER CONSOLE - INTERACT AT

The Mixer Console allows you to create mixes of audio and send them to specific outputs. This allows you
greater flexibility in setting up your conferencing environment. The Audio Inputs are shown along the left side
of the window and the Audio Outputs are along the top.

» NOTE: There are several routing paths that are inactive. This is to prevent audio from being
routed back to the source and creating feedback.

Mixer Options

e Select the check boxes for the Audio Inputs you want routed to each output.

e You can adjust volume on the inputs and outputs, using the corresponding volume sliders. Each volume
slider is independent of any other volume control in the mixer. To view a meter the corresponding check
box must be selected.

The meters are peak meters which measure the audio level. The meter bars move from green to yellow to
red as the volume increases. The red bars indicate that the audio is too loud and is being clipped or cut off.

Click any of the Mute buttons to mute an input or output. Each Mute button is independent of any other
Mute control in the mixer.

Click Close to return to the main flow screen.

LINE INPUT SETTINGS - INTERACT AT

The Line Input Settings window is used to customize and configure the audio from the auxiliary device that
is connected to the Line In jack on the INTERACT mixer. Line Input devices include video codecs, CD players
and sound cards.

»  NOTE: Many of the most common Line Input devices have been pre-configured for optimal
performance with the INTERACT system. These devices are listed in the Device Toolbox.

Adding A Device Label

e You can add the Manufacturer and Model of your connected Playback device using a serial
command.

e You can also add your Playback device to the Device Toolbox using the Device Toolbox Editor, which
allows you to specify the Manufacturer and Model.

Equalization

* Increase and decrease the Low, Mid and High frequencies using the Equalization Sliders. Levels can
be adjusted from +12 dB to — 12 dB.

e Equalization in INTERACT Software is very similar to bass and treble adjustments on a stereo. Increasing
or decreasing the different frequencies allows you to customize loudspeaker audio and provide the
optimal listening experience for your users. Using this feature is optional.

Chapter 2: Getting Started
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Mute
* Press the Mute button to silence audio on the Line Input.

Meters and Volume

1. Get an Audio Signal from the Line Input device.
2. Adjust the Audio Level using the Volume slider.

* The Peak Meters are used to measure the Audio Level with the meter bars moving from green to yellow
to red as the volume increases. The red bars indicate that the audio is too loud and is being clipped or
cut off.

CAMERA CONTROL

The INTERACT system provides voice tracking capabilities through VISCA control port connection to a
PTZ camera. The camera presets are programmed within the INTERACT Software and assigned to each
microphone pod. The INTERACT AT supports nine camera positions as well as a home position.

Camera Control Settings
e With the camera connected, click the Camera Controls button on the configuration window.

Select the Camera Control Mode, either Sony or Cannon.
If you have more than one camera, select which camera you are programming.

3. Select the Camera Delay. Camera Delay is the amount of time the microphone must be activated
before the camera moves to the preset position.

Select Voice Tracking System Enabled.

Using the Directional Arrow buttons and the Zoom In and Zoom Out buttons, position the camera for
the first microphone pod.

6. Click Save Preset under the microphone pod to assign the camera position to the microphone.
Repeat steps 1-6 for the second and third microphones.

* Click Run Preset to test the preset programming for the microphone pod.

Technical Support: 800-283-5936



DIALER - INTERACT AT

In addition to the INTERACT Controller, you can manage calls through the Dialer from within the INTERACT
Software. You can dial a number, redial the last dialed call, and disconnect calls. You can also use hook flash
function, mute the microphones and adjust call volume.

Making and Receiving Calls

» NOTE: A connection must be present for the dialer to work on the AT. A connection is not
necessary for the INTERACT Pro.

e (lick the Dialer icon on the configuration screen.

Dialer

Click the ON/OFF key. You will hear a dial tone.
2. Dial the number as you would on a standard phone. The number appears on the LCD screen as it dials.

»  NOTE: You can also pre-dial the number and then press the ON/OFF key to connect the call.
Press and hold the pound key (#) to enter a pause in the dialing string.

. Select the number in the Phonebook list. The name and number appear in the display window.
2. Click the ON/OFF button to dial the displayed number.

»  TIP: You can also double-click the number in the Phonebook list to initiate a call.
¢ (Click the ON/OFF button.

¢ (Click the Redial button.

e If your telephone service includes call transfer, call waiting or conference calling, you can use the Flash
button to invoke these features. Refer to your local telephone service provider for details.
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Call Settings

Click the Mute button to mute all microphones.
e Click the Mute button again to unmute all the microphones.

e Use the Up and Down buttons to adjust the call volume to the desired level.

e (Click the Switch to Flow Window button to return to the configuration screen.

e Click either the Office Communicator (OCS) button to communicate via Microsoft Office
Communicator or the Telco button to switch the dialer back to its normal communication mode.

LINE OUTPUT SETTINGS - INTERACT AT

The Line Output Settings window is used to customize and configure the audio being sent to the auxiliary
device connected to the Line Out jack on the INTERACT mixer. Line Output devices include Video Codecs,
CD Players, Amplifiers and Sound Cards.

»  NOTE: Many of the most common Line Output devices have been pre-configured for optimal
performance with the INTERACT system. These devices are listed in the Device Toolbox.

Adding a Device Label

e You can add the Manufacturer and Model of your connected Playback device using a serial
command.

e You can also add your Playback device to the Device Toolbox using the Device Toolbox Editor, which
allows you to specify the Manufacturer and Model.

Equalization

* Increase and Decrease the Low, Mid and High frequencies using the Equalization Sliders. Levels can
be adjusted from +12 dB to — 12 dB (INTERACT AT only).

e Equalization in INTERACT Software is very similar to bass and treble adjustments on a stereo. Increasing
or decreasing the different frequencies allows you to customize loudspeaker audio and provide the
optimal listening experience for your users. Using this feature is optional.

Meters and Volume

1. Get an audio signal from the line output device.
2. Adjust the Volume using the Volume slider.

* The meters are peak meters measuring the audio level. The meter bars move from green to yellow to red
as the volume increases. The red bars indicate that the audio is too loud and is being clipped or cut off.

Technical Support: 800-283-5936



COMMUNICATIONS SETTINGS - INTERACT AT

Your INTERACT system can be controlled through the network or through the serial connection. You can
also connect a PTZ camera to the Camera port and use the Voice Tracking feature (not available on the
INTERACT Pro).

Network Settings

» NOTE: Contact a Network Administrator for information on current network settings and
permissions.

Create a unique network name and enter it in the Network Name field - the default is ClearOne.
If your network is DHCP enabled, the IP Address, Subnet and Gateway information will be filled in.

If your network is not DHCP-enabled or if you require a static IP address, clear the Use DHCP check box
and enter the IP Address, Subnet and Gateway addresses.

4. Select Use DNS if you have a Domain Name Server and want name resolution (to use a network name)
for your static IP address.

5. Seta Use Name and Password for access when connecting over IP The default user name is:
clearone. The default password is: interact - these are not case sensitive.

6. Click Ok to save the settings and close the window.

* Enter specific IP addresses that will be allowed to access the INTERACT system.

e [P filters allow you to restrict access to your INTERACT system. Only computers with the specified IP
address can connect to INTERACT.

* You can specify a range of IP addresses by using zeros. For example, entering 192.168.105.0 will allow
any IP addresses in the 192.168.105.1 to 192.168.105.254 range to access the INTERACT system.

Serial Port Settings (AT Only)

1. If you are connecting a camera for voice tracking mode, set the Baud Rate to match the baud rate
indicated in the camera specifications.

Select Flow Control to enable hardware flow control.
Click Ok to save settings and close the window.

1. Select the Control Port Baud Rate that matches the baud rate of the PC COM port or the control
device.

Select Flow Control to enable hardware flow control.
Click Ok to save settings and close the window.

* Flow Control is the regulation of the transmission and reception of data between two devices.
ClearOne recommends enabling Flow Control on the INTERACT system.
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Radio Settings - INTERACT Pro and AT
The Radio Settings tab allows the user to customize wireless settings for INTERACT components.

1.
2.

2.

Click Radio Enable to activate/deactivate the wireless radio used by the INTERACT hardware.

Radio Frequency is selected by clicking on and selecting a frequency from the Radio Frequency drop
box.

Assign a unique ID to your INTERACT device.

ClearChannel Assessment scans the radio channel frequency chosen for your INTERACT device and
reports whether there is traffic on that frequency. Click Run to start this process.

Click the Enable Radio Statistics check box to display Link Quality, RSSI Level and Packet Error
statistics for the device.

Click Ok to save your changes.

RECORD OUTPUT SETTINGS - INTERACT AT

The Record Output Settings window is used to customize and configure the audio being sent to the
recording device that is connected to the Record jack on the INTERACT mixer. Recording devices include
VCRs, DVD players, and sound cards.

»  NOTE: Some of the most common recording devices have been pre-configured for optimal
performance with the INTERACT system. These devices are listed in the Device Toolbox.

Adding a Device Label

You can add the Manufacturer and Model of your connected Playback device using a serial
command.

You can also add your Playback device to the Device Toolbox using the Device Toolbox Editor, which
allows you to specify the Manufacturer and Model.

Meters and Volume

Increase and decrease the Low, Mid and High frequency tones using the Equalization Sliders. Levels
can be adjusted from +12 dB to —12 dB.

The meters are peak meters which measure the audio level, the nominal level is -10 dBu. The meter bars
move from green to yellow to red as the volume increases. The red bars indicate that the audio is too
loud and is being clipped or cut off.

Technical Support: 800-283-5936



MIC AND MIC EX SETTINGS - INTERACT AT ONLY

Level

The Level tab lets a user adjust level settings for each of the INTERACT MIC’s three microphones
independently.

Fine Gain: Use the slider to adjust Fine Gain for each Mic Input independently

Level Meter: Displays current levels for each Mic Input

ALC: Click the ALC button to activate Auto Level Control for each Mic Input independently
Mute: Click the Mute button to mute each input independently

P Pwr (MIC EX only): Click the P Pwr button to enable Phantom Power for the Mic channel.

Processing
The processing tab adds processing and filters to each microphone based on user preference.

AEC: Click the AEC button to activate Acoustic Echo Cancellation
NLP: Default is Soft. Click a radio button to set the Non-Linear Processing level or deactivate the feature.

NC.: Click the NC button to activate/deactivate Noise Cancellation. Use the slider to adjust the amount of
noise cancellation used for that microphone.

Speech Lift: Click the Speech Lift button to route the microphone’s audio to the Loudspeaker output.
Use the Speech Level Slider to set the desired level (the default is -6 dB).

Filter: Click to apply filtering to each independent Mic Input.

Start by clicking Add Filter

°  Adjust the filter placement by moving the point along the grid (Hz, dB/deg).
» Alternatively, click Table View to apply a list view.

°  To adjust the active filter, click the fields along the top row.

Active Filter: Selects the filter to adjust

Type: Sets the type of filter applied

Frequency: Adjusts the frequency of the filter

Gain: Increases or decreases gain applied to the filter

Q: Increases or decreases the Q applied to the filter

Bandwidth: Adjusts the filter's bandwidth

Bypass: Bypasses the filter completely

v Vv Vv Vv Vv v Vv

° To add phasing to a filter, click Phase

°  Click Bypass All to override all filter settings

°  Click Remove Filter to delete the selected filter

°  Click Close to apply settings and close the window

°  Toremove an existing filter, open the Processing tab, click Remove Filter and Close.
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Gating
Click the Gating tab to access microphone gating features.

The Gating tab screen provides the user access to setting the Gate Mode, Gate Ratio, Hold Time,
Attenuation, Decay Rate and Control Chairman Override parameters for each microphone.

Set Gate Mode allows you to set the gate mode. Choices are limited to Manual On, Override On and Auto.
* Manual On: Activates a Mic - the microphone contributes to gating parameters.

* Manual Off: Deactivates a Mic - the microphone no longer contributes to gating parameters.

e Override On: Activates a Mic - the microphone does not contribute to gating parameters.

e Auto: Automatically gates the Mic on or off, based on input levels and other parameters programmed
into the INTERACT AT.

* PA Adaptive Mode: Uses the audio level on a specified output as the new ambient level when audio
is present at the power amplifier. This prevents loudspeaker audio from gating on the mic while still
allowing people in the room to gate on microphones when they speak (provided that their voices are
louder than the loudspeaker audio). For example, you might decide to play background music from a
CD player during a presentation. PA Adaptive Mode allows you to use the output routed from the CD
player as the ambient reference to prevent the CD player’s audio from gating on microphones. The
default is Off.

Gate Ratio specifies how much louder the Mic audio level must be above the ambient noise level before the
Mic gates on.

e Using the slider, adjust the gate ratio to the desired level.

Adjust hold time allows you to set how long the channel stays gated on after the Mic gates off.
e Using the slider, adjust the hold time to the desired level.

Set decay rate allows you to set how quickly a Mic gates off after the hold time expires.
* Click the Decay Rate radio button for the desired amount of decay after the gate is lost.

Chairman override provides gating priority for a Mic. When a Mic with chairman override enabled gates on,
all Mics that don’t have chairman override enabled will gate off.

¢ (Click the Chairman Override radio button enable the chairman override feature.

Technical Support: 800-283-5936



PLAYBACK INPUT SETTINGS - INTERACT AT

The Playback Input Settings window is used to customize and configure the audio from the playback device
that is connected to the Playback jack on the INTERACT mixer. Playback devices include VCRs, DVD players
and sound cards.

» NOTE: Some of the most common Playback devices have been pre-configured for optimal
performance with the INTERACT system. These devices are listed in the Device Toolbox.

Adding a Device Label

* You can add the Manufacturer and Model of your connected Playback device using a serial command.

* You can also add your Playback device to the Device Toolbox using the Device Toolbox Editor, which
allows you to specify the Manufacturer and Model.

Equalization

e Equalization in INTERACT Software is very similar to bass and treble adjustments on a stereo.
Increasing or decreasing the different frequencies allows you to customize loudspeaker audio and
provide the optimal listening experience for your users. Using this feature is optional.

Stereo Mix

e Select Stereo Mix if your external device uses Stereo Inputs/Outputs. The INTERACT provides
mono-only audio from stereo devices. By selecting Stereo Mix you ensure the proper level adjustments

are made to your audio.

Meters and Volume

* Get an Audio Signal from the line Input Device.
e Adjust the Volume using the Volume Slider.

* The meters are peak meters measuring the audio level. The nominal level is -10 dBu. The meter bars
move from green to yellow to red as the volume increases. The red bars indicate that the audio is too
loud and is being clipped or cut off.
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TELEPHONE SETTINGS - INTERACT AT
You can set user Telephone Preferences as well as Country and Flash settings in the Telephone Settings
window.

Telephone Settings

e Select 2 Rings or 4 Rings for the Auto Answer setting, or Disabled if you want to manually answer
calls.

* Select Auto Disconnect if you would like INTERACT to disconnect when it detects loop-drop or call
progression.

e Select Audible Connect if you would like one tone to sound when the INTERACT is taken off hook and

two tones to sound when the INTERACT is on hook.

* Select from three available ringer melodies or deactivate the ringer. Click Ringer Test to hear the
selected ringer.

e Adjust ringer volume using the Ringer Level Slider.

e Enter the Local Number for the INTERACT system. This will display on the tabletop controller LCD.

* Select the Country or Region where the phone is being used (default is US/Canada)
* Select Flash duration from the Flash Settings list. This setting is dependent on your PBX system.

* Receive ALC (Auto Level Control) is activated by default. ALC keeps the telephone audio level
consistent with audio levels coming from other sources If de-selected, the following options will be
available:

° Telco Receive Volume allows you to adjust incoming volume

» TEC: Click to activate Telephone Echo Cancellation. This feature cancels sidetone from the

Headset Receive.
» NLP: Click to activate Non-Linear Processing

» DTMF: Adjust the level of the DTMF tones that return to the room.
°  Telco Transmit Volume allows you to adjust outgoing volume (always available)
* (Click Ok to save your settings.

Technical Support: 800-283-5936



LOUDSPEAKER SETTINGS - INTERACT AT

You can customize your loudspeaker audio in the Loudspeaker settings window of the INTERACT Software.

ClearEffect™

e Click the ClearEffect On/Off button. The indicator will turn green when ClearEffect is enabled. This
setting only effects Telco receive audio.

* When ClearEffect is enabled, it causes the audio coming from the telephone line to emulate wideband
audio. It does this by adding high and low frequencies to the audio signal, creating a fuller sound. Using
this feature is optional.

Equalization

* Increase and decrease the Low, Mid and High frequencies using the Equalization sliders. Levels can be
adjusted from +12 dB to — 12 dB.

e Equalization in INTERACT Software is very similar to bass and treble adjustments on a stereo. Increasing
or decreasing the different frequencies allows you to customize loudspeaker audio and provide the
optimal listening experience for your users. Using this feature is optional.

Mute
e Click Mute to silence all output to the loudspeakers.

Meter and Volume

* The loudspeaker volume has been optimized for use with the INTERACT system. You can increase or
decrease loudspeaker volume as desired.

e The meters are peak meters which show the audio level. The nominal level is -10 dBu. The meter bars
move from green to yellow to red as the volume increases. If the meter shows red, decrease the volume.
Red indicates clipping.
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INTERACT COM SETTINGS - INTERACT AT
Click the Headset/USB/RF drop down to add a headset to the INTERACT mixer console. Once selected,
click the headset icon to launch the Headset USB Settings window.

Telephone Mode

Check to adjust settings for this telephone mode.

e Telco/Headset Rx: Adjusts the Telco/Headset Receive Levels
¢ Telco/Headset Tx: Adjusts the Telco/Headset Transmit Levels
* USB Rx: Adjusts the USB Receive Levels
e USB Tx: Adjusts the USB Transmit Levels
e Mute: Click the Mute button to mute any of the above settings.

Check to adjust the headset configuration.

* Telephone Set: Click the drop down to select the telephone set you will use with the headphone/USB
Breakout Box configuration.

* RJ 11 Pin Out: Choose the drop-down setting which best describes your pin out configuration.
* Speaker Gain: Adjusts headset Speaker Gain
* Mic Gain: Adjusts headset mic gain

* Telephone Line Echo Cancellation: (Default On) Activates/Deactivates Telephone Line Echo
Cancellation

* Non-Linear Processing: (Default On) Activates/Deactivates Non-Linear Processing
e Automatic Level Control: (Default On) Activates/Deactivates Automatic Level Control

» Standard Mode or Office Communicator/Lync Mode: Chooses between either Standard USB Mode
or Office Communicator Mode (used only with Microsoft Office Communicator or Microsoft Lync).

The USB Configuration is used to define the function of the “PC” button on the wired and wireless
controllers. When in Standard Mode, the PC button and the Telephone button on the controller have the

same function. In this mode, the controller is always used to initiate Telco calls, regardless of whether the

“PC” or “Telephone” button has been pressed.

However, when the USB Configuration is set to Office Communicator Mode, pressing the “PC” button
on the controller allows the controller to dial Office Communicator or Lync calls when OC or Lync are
running on the connected PC. When in this mode, the status displayed on the controller changes to
“Lync” when the “PC” button is pressed.

Technical Support: 800-283-5936



Chapter 3: Compliance
COMPLIANCE

»  WARNING: The country code must be set correctly in the INTERACT software to ensure that
the unit operates properly when connected to the Telco network, and that it complies with the
country’s Telco requirements. Changing this code to a country other than the intended country
of operation might cause thr INTERACT Pro & INTERACT AT devices to be non-compliant.

FCC Part 15/ICES-003/RSS-210 Compliance
FCC ID:FBICOM (INTERACT COM-W)

FCC ID:FBIDIALER (INTERACT DIALER-W)
IC:1970A-COM (INTERACT COM-W)
IC:1970A-DIALER (INTERACT DIALER-W)

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part
15 of the FCC rules and Industry Canada ICES-003. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference, in which case the user will be required to correct the
interference at his/her own expense.

This device complies with Part 15 of the FCC Rules and Industry Canada ICES-003. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept
any interference received including interference that may cause undesired operation.

Changes or modifications not expressly approved by ClearOne Communications could void the user’s authority
to operate the equipment.

This equipment must be installed by qualified professionals or contractors in accordance with FCC Part 15.203
& IC RSS-210, Antenna Requirements. Do not use any antenna other than the one provided with the unit.

This device has been designed to operate with the antenna listed below, and has a maximum gain of 2.0 dB.
Antennas not included in this list of having a gain greater than 2.0 are strictly prohibited for use with this device.
The required antenna impedance is 50Q.

Pulse Model W1030

To reduce potential radio interference to other users, the antenna type and its gain should be chosen so that the
Equivalent Isotropic Radiated Power (E.I.R.P) is not more than that permitted for successful communication.

FCC/IC RF Radiation Exposure Statement

This equipment complies with the FCC/IC radiation exposure limits set forth for portable transmitting devices
operating in an uncontrolled environment. End users must follow the specific operating instructions for
satisfying RF exposure compliance.

* The equipment should only be used or installed at locations where there is normally at least a 20cm
separation between the antenna and all persons.
» NOTE: The DIALER-W contains an internal antenna while the COM-W uses an external
antenna.
e This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

e Changes or modifications not expressly approved by the party responsible could void the user’s authority
to operate this equipment.

Technical Support: 800-283-5936



FCC Part 68 Compliance
US: FBIBROOBINTERACT
Ringer Equivalence Number (REN): 0.0B(ac)

This equipment complies with Part 68 of the FCC Rules Requirements adopted by ACTA . The mixer unit of
this equipment contains, among other information, a product identifier in the format US:AAAEQ# # TXXXX. If
requested, this information must be provided to your telephone company.

The REN is used to determine the number of devices that may be connected to the telephone line. Excessive
RENSs on the telephone line may result in the devices not ringing in response to an incoming call. In most, but
not all areas, the sum of the RENs should not exceed five (5.0). To be certain of the number of devices that
may be connected to the line, as determined by the total RENs, contact the telephone company to obtain
the maximum RENSs for the calling area. The REN for this product is part of the product identifier that has the
format US:AAAEQ# #TXXXX. The digits represented by ## are the REN without a decimal point (e.g. 03 is a
REN of 0.3).

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. If advance notice isn’t practical, the telephone company
will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the
FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that could
affect the operation of the equipment. If this happens, the telephone company will provide advance notice in
order for you to make the necessary modifications to maintain uninterrupted service.

This equipment uses an RJ11C jack that is used to connect this equipment to the premises wiring and telephone
network. This RJ11C jack complies with the applicable FCC Part 68 Rules and Requirements adopted by
the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be
connected to a compatible modular jack that is also compliant. See installation instructions for details.

»  WARNING: The country code must be set correctly in Console to ensure that the unit operates
properly when connected to the Telco network, and that it complies with the country’s Telco
requirements. Changing this code to a country other than the intended country of operation
might cause INTERACT devices to be non-compliant. 304.

If you experience problems with this equipment, contact ClearOne Communications, 5225 Wiley Post Way,
Suite 500, Salt Lake City, Utah 84116, or by phone at (800) 945-7730 for repair and warranty information. If the
equipment is causing harm to the telephone network, the telephone company may request that the equipment
be disconnected until the problem is resolved.

No user serviceable parts are contained in this product. If damage or malfunction occurs, contact ClearOne
Communications for instructions on its repair or return.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public
service commission or corporation commission for information. This equipment cannot be used on telephone
company provided coin service.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of
this equipment does not disable your alarm equipment. If you have questions about what will disable alarm
equipment, consult your telephone company or a qualified installer.

Electrical Safety Advisory

This equipment uses AC power which can be subjected to electrical surges, typically lightning transients which
are very destructive to customer terminal equipment connected to AC power sources. The warranty for this
equipment does not cover damage caused by electrical surge or lightning transients. To reduce the risk of this
equipment becoming damaged it is suggested that the customer consider installing a surge arrestor.
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IC Compliance
IC: 1970A-INTERACT

Ringer Equivalence Number (REN): 0.0B(ac)

NOTICE: The term “IC” before the certification/registration number signifies that Industry of Canada technical
specifications were met.

This certification means that the equipment meets certain telecommunications network protective operational
and safety requirements. The Department does not guarantee the equipment will operate to the user’'s
satisfaction.

The REN is used to determine the number of devices that may be connected to the telephone line. Excessive
RENSs on the telephone line may result in the devices not ringing in response to an incoming call. In most, but
not all areas, the sum of the RENs should not exceed five (5.0). To be certain of the number of devices that
may be connected to the line, as determined by the total RENs, contact the telephone company to obtain the
maximum RENSs for the calling area. The REN for this product is listed above.

Before installing this equipment, users should ensure that it is permissible to be connected to the facilities of
the local telecommunications company. The equipment must also be installed using an acceptable method of
connection. In some cases, the companies inside wiring associated with a single line individual service may
be extended by means of a certified connector assembly (telephone extension cord). The customer should be
aware that compliance with the above conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated
by ClearOne Communications. Any repairs or alterations made by the user to this equipment, or equipment
malfunctions, may give the telecommunications company cause to request the user to disconnect the
equipment.

Users should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines and internal metallic water pipe system if present, are connected together. This precaution
may be particularly important in rural areas.

European Compliance
Details on European equipment compliance can be found on the ClearOne website at the following location:

www.ClearOne.com/resources/EuroDOC.php

Australia Compliance
In the event of main power failure, INTERACT equipment will become inoperable with regard to making
telephone calls.

China Compliance
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Technical Support: 800-283-5936


www.ClearOne.com/resources/EuroDOC.php

New Zealand Compliance

In the event of main power failure, INTERACT equipment will become inoperable with regard to making
telephone calls.

All persons using INTERACT equipment for recording telephone conversions shall comply with New Zealand
law, which requires that at least one party to the conversation be aware that the conversation is being recorded.
In addition, the principles enumerated in the Privacy Act of 1993 shall be complied with in respect to the nature
of any personal information collected, the purpose of this collection, how it is used and what is disclosed to
any other party.

South Korea Compliance
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English Translation: This radio device has the possibility of radio interference during operation.

lgedLBDDls 28 & 31
g = glsut

English Translation: This radio device is not allowed to be used for human safety since it has the possibility
of radio interference during operation.

ﬂOI'

ALOF

olr

0| YOS 2 01 orA 1}

AN — —

FE

gE MblA

rr

ol

0l J101= g9R2(A3)22 MXILHESES & J17101L] =l
REE AFBRHE 0 B2 FOIGHAIZ B2t JHE 2/2l X0l Al

AMEdte As SH2Z gL

English Translation: The equipment is for business use (Class A), and has acquired electromagnetic
conformity registration. Sellers and users are required to take caution in this regard.

Taiwan Compliance
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According to “Administrative Regulations on Low Power Radio Waves Radiated Devices” Without
permission granted by the NCC, any company, enterprise, or user is not allowed to change frequency,
enhance transmitting power or alter original characteristic as well as performance to an approved low power
radio-frequency devices. The low power radio-frequency devices shall not influence aircraft security and
interfere legal communications. If found, the user shall cease operating immediately until no interference is
achieved. The said legal communications means radio communications is operated in compliance with the
Telecommunications Act.

The low power radio-frequency devices must be susceptible with the interference from legal communications
or ISM radio wave radiated devices.
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